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Gmail 
 

Overview 
 
Gmail is a free email service from Google. It includes 10GB (and 
counting) of free storage, and in many ways works like any other email 
service, but it also has some unique features. A Google account gives 
you access to Gmail in addition to other Google services including 
Google Drive, Calendar, YouTube, Google+, and more. 
 

The Interface 
 

 
 

Inbox 
 
The Inbox contains your new messages—both read and unread. After 
you archive a message, it will no longer appear in the Inbox but can still 
be easily found. New messages appear in bold. The number in 
parentheses next to the Inbox (3) label indicates the number of unread 
messages in your inbox. 

Search box: Searches all messages. 

Gear icon: 
Change your 
settings or get 
help. 

Account buttons: 
When a message is 
selected, allows you to 
archive, label, etc. 

Gmail Drop-Down: 
Select Mail, Contacts, or 
Tasks List here. 

Labels: 
Organize messages by 
applying one or more labels. 

KEEP IN MIND 
A single message can exist in 
multiple places. A message 
can be in the Inbox, have two 
labels, and be found in All 
Mail, for example. 
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Priority Inbox 
Priority Inbox is an optional new Gmail feature that is essentially the 
opposite of the spam filter. It tries to identify which messages are the 
most important and puts those messages at the top of your inbox. 
 
 
You can enable the Priority Inbox by clicking the down arrow that 
appears when the mouse pointer is over the Inbox label, and then 
selecting Priority Inbox. 
 

 
 

Spam Filtering 
Spam filtering happens automatically. Gmail flags messages that it 
thinks are spam and places them in the Spam folder. This folder is 
emptied periodically, but is worth checking from time to time as the 
spam filter may occasionally catch a message that is not actually spam. 
If someone claims to have emailed you, and you have not received 
anything, this is the place to check. 
 

Threaded Messages / Conversation View 
 
Conversation view takes a bit of getting used to, but tends to be very 
helpful. It automatically groups emails and their replies and forwards, 
keeping your inbox organized and making it easy to reference past 
emails in the thread. 
 

 
 
In your inbox, email threads with multiple messages appear as a single 
line, as in the example above. You can tell that it is a thread by the 
number next to the recipients: “Brynn, me, Brynn (3)”. When you select 

TRAINING GMAIL 
You can train the Gmail spam 
filter. For messages in the 
Spam folder that are not spam, 
select the message and click 
Not Spam. For messages that 
appear in your inbox that are 
spam, select the message and 
click the  Report spam 
button. 
 
You can always add a sender 
to your contacts to ensure that 
no email from them ever goes 
into spam by mistake. 
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the thread in your inbox and apply labels, archive, or delete, the action 
will apply to the whole thread. 
 
If you have already assigned a label to a thread, any future messages in 
the thread will automatically include the label. 
 

 
 
When you click on a threaded email in the inbox, it opens the full thread 
but compacts the messages within the thread that you have already read. 
In the example above, the first two messages are compacted, but the 
new reply is visible in full. You can easily view the earlier messages in 
full by clicking on them. 

Archive 
 
Gmail suggests archiving all your email instead of deleting anything. I 
prefer to delete any mailing list and other emails that I know I will not 
want to access again, and then archive the rest. 
 
Archiving an email simply removes it from the inbox. Your mail is still 
searchable and can also be found in the All Mail folder in the left 
sidebar. 
 
To archive an email, just select the thread and click the  Archive 
button. 
 
 

FOR YOUR EYES ONLY? 
See which messages were 
sent right to you. 
 
Personal level indicators put 
arrows next to messages. A 
single arrow (>) is for emails 
sent to both you and others, 
while a double arrow (>>) 
indicates emails sent just to 
you. 
 
Turn Personal level indicators 
on in Settings. 



 
 

 

 

Gmail and Google Drive    APRIL 22, 2013 – PAGE 5 

Labels 
 
Labels allow you to organize the messages in your inbox. You can apply 
more than one label to any message, and create new labels to organize 
your messages any way you want. 
 
To create a new label, click the More ˅ link that appears when the 
mouse pointer is over the labels in the sidebar, then select Create new 
label. 
 

 
 
You can choose colors for your labels to help them stand out. Click the 
down arrow that appears when the mouse pointer is over a label, then 
select a color and choose any other options. 
 
To assign a label to an email, select the email, click the Label button, 
select as many labels as you would like to assign, and click Apply. 
 

 
 
After assigning a label, that label will appear next to the subject of the 
email anywhere it appears. 
 

 

LABEL MANIA 
Here are a few labels you may 
want to create: 
 

• FollowUp 
(for emails which you need 
to respond to) 

• Lists 
(from e-newsletters and 
other mailing lists you may 
be on) 

• Business 
• Family 
• Personal 
• Recipes 
• Travel 
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You can view all messages with a certain label by clicking on that label 
in the sidebar label list. 
 
In addition to the Label button there is a Move to button. Using this 
option instead assigns a label to the selected thread and then archives 
the thread automatically. This works like email folders in other email 
systems you may be used to. 
 

Search 
 
The search feature in Gmail is incredibly powerful. Just typing a 
keyword search in the search box usually gets you what you need, but 
there are many more advanced search options. You can find many of 
these search options by clicking the down arrow at the right of the 
search box, resulting in the advanced search box displaying. 
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You can also use search operators in the search box to manually 
perform complex searches. Operators can be combined. Here are a few 
of them: 
 
from: Used to specify the sender Example: from:amy 

Meaning: Messages from Amy 

to: Used to specify a recipient Example: to:david 
Meaning: All messages that were sent to David (by 
you or someone else) 

OR Search for messages matching 
term A or term B* 
*OR must be in all caps 

Example: from:amy OR from:david 
Meaning: Messages from Amy or from David 

label: Search for messages by label Example: from:amy label:friends 
Meaning: Messages from Amy that have the label 
"friends"  

Example: from:david label:my-family 
Meaning: Messages from David that have the label 
"My Family" 

" " 
(quotes) 

Used to search for an exact 
phrase* 
*Capitalization isn't taken into 
consideration 

Example: "i'm feeling lucky" 
Meaning: Messages containing the phrase "i'm 
feeling lucky" or "I'm feeling lucky" 

Example: subject:"dinner and a movie" 
Meaning: Messages containing the phrase "dinner 
and a movie" in the subject 

in:anywhere Search for messages anywhere 
in Gmail* 
*Messages in Spam and Trash 
are excluded from searches by 
default 

Example: in:anywhere movie  
Meaning: Messages in All Mail, Spam, and Trash 
that contain the word "movie" 

in:inbox 
in:trash 
in:spam 

Search for messages in Inbox, 
Trash, or Spam 

Example: in:trash from:amy 
Meaning: Messages from Amy that are in Trash 

 
For a full list of operators, visit 
http://support.google.com/mail/answer/7190 

Chat 
 
You can send instant messages to any contacts who are also using 
Gmail. There are also voice and video chat options within the chat 
feature. The chat window is located below the labels on the left. 
 
Chat also allows you to make voice calls to any phone number. Calls 
within the US are free, and international calling is available for a fee. 
For more information visit 
http://support.google.com/chat/bin/answer.py?hl=en&answer=187614 

http://support.google.com/mail/answer/7190�
http://support.google.com/chat/bin/answer.py?hl=en&answer=187614�
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Sending an Email 
 
To send an email, click the big red Compose button in the left sidebar. 
 
You can add Cc and Bcc recipients if you wish. Cc stands for carbon 
copy, and allows you to include additional recipients who the email may 
not directly affect. Bcc stands for blind carbon copy. Anyone listed in 
the Bcc field will not be visible to any of the other recipients. It’s a good 
way to secretly send a copy of your email to someone else, but there is a 
slight risk: the Bcc recipient could Reply all to the email, in which case 
the other recipients will become aware that you secretly sent your 
message to this other person. 
 

 
 
 
 
 
 
 
 
 
 

Enter the recipient here 

Click here to add Cc or 
Bcc recipients 

Attach files and 
images here 

Click the Pop out 
button to open the new 
message in a separate 
window. 

OOPS! 
Hit Send too soon? Give 
yourself a grace period of a 
few seconds to cancel 
sending, then edit your 
message before sending 
again. 
 
Turn it on in Labs, which you 
can find in your Gmail settings. 
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Replying to an Email 
 
To reply to an email, you can either click the Reply button (click the 
down arrow next to the buttons for more options, including Reply All 
and Forward) or just click in the reply box below the email and start 
typing. 
 

 
 
 

Contacts 
 
You can view your contacts at any time by clicking the red “Gmail ˅” 
link toward the top left corner and selecting Contacts. You can view, 
add, and organize your contacts here. 
 
To send an email to one of your contacts, you can select the contact here 
and then click the  Email button, or just start typing the contact’s 
name in the New Message window and select the contact that appears 
automatically. 
 
 
 
 
 

Click here to reply. 

Or click here to reply. 

Click here for more options. 
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Changing Settings 
 
Click on the gear near the top right corner to access Settings, where you 
can manage labels, change inbox settings, set up filters, and change the 
theme, affecting the appearance of Gmail. 

Setting up a Filter 
Within Settings, click Filters and then Create a new filter. 
 

 
 
Enter filtering information in one or more of the fields, then click 
Create filter with this search > in the bottom right corner of the filter 
window. 
 

 
 
Choose what to do with the resulting messages, then click the Create 
filter button. 
 
In the example above, I’m creating a filter that automatically applies the 
Personal label to any emails from bwhite@nysoclib.org. 
 
Learn more about filters at http://support.google.com/mail/answer/6579 
 

mailto:bwhite@nysoclib.org�
http://support.google.com/mail/answer/6579�
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Creating a Gmail Account 
 
To create a new Gmail account, go to http://www.gmail.com/ and click 
on the red CREATE AN ACCOUNT button in the top right corner. 
 
Enter the following information on the next page: 
 

• Your name 
• Choose an email address 
• Create a password 

o You should not use a password that you use for other 
accounts. Your email is how other accounts are verified, 
so it’s important to keep a secure password. 

o The most secure passwords use a combination of letters, 
numbers, and special characters (like -, $, #, etc.) 

• Enter your birthday 
o If you prefer not to provide this information to Google, 

you may want to choose a date somewhere in the vicinity 
of your birthday. 

o Your birthday won’t be displayed without your 
permission. 

• Select your gender 
• Enter a mobile phone number 

o This is optional, but providing a number helps keep your 
account safe, and provides a way to get back into your 
account if you lose your password. 

• Current email address 
o This is optional, and also helps with account security and 

recovery. 
• Prove you’re not a robot by entering the captcha text 
• Select your location 

o United States is selected by default. 
• Check the box agreeing to the Terms of Service and Privacy 

Policy 
• Optionally, check the box allowing Google to use account 

information to personalize Google+ content and ads on other 
websites. 

o More information here: 
https://support.google.com/plus/answer/1152622 

 
Then just click the Next step button, and you’re all set! 
 
 
 
 
 
 

KEYBOARD SHORTCUTS 
If you enable keyboard 
shortcuts in Gmail, you can 
really speed things up! 
 
Keyboard shortcuts let you 
navigate through your 
messages, within your 
conversations, archive a 
conversation, and jump to your 
inbox, without having to use 
the mouse. 
 
A list of keyboard shortcuts 
can be viewed at 
http://support.google.com/mail/
answer/6594 

SIGNING OUT 
Remember to sign out from 
Gmail if you’re using a public 
computer! 
 
To sign out, just click on your 
email address in the top right 
corner, and choose Sign out. 

http://www.gmail.com/�
https://support.google.com/plus/answer/1152622�
http://support.google.com/mail/answer/6594�
http://support.google.com/mail/answer/6594�
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Migrating from Another Account 
 
When you sign up for a new Gmail account, you will be asked if you 
would like to import email and contacts from another account. To do so, 
click the Import mail and contacts button. You can also import mail 
and contacts if you already have a Gmail account by going to Accounts 
and Import in Settings and selecting Import mail and contacts. 
 
You will then be prompted for the email address that you want to import 
from, and will be guided through the process. Gmail will need that 
email address and password, and possibly some server information if 
you’re importing from an email address that is not hosted at one of the 
main email providers. 
 
After importing your old email and contacts, you might want to set up 
email forwarding on your old account to automatically send any future 
emails that come to your old address to your new Gmail address. 
Consult the help or documentation from your previous email provider 
for information on how to set this up. 
 

 
 

GMAIL IN OUTLOOK 
Want to access your Gmail 
email from Microsoft Outlook, 
or any other email client? You 
can! 
 
View the guide at 
http://support.google.com/mail/
troubleshooter/1668960?hl=en 
for information about setting 
this up. 

http://support.google.com/mail/troubleshooter/1668960?hl=en�
http://support.google.com/mail/troubleshooter/1668960?hl=en�
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Google Drive 
 
Google Drive is a cloud storage and computing service, allowing you to 
access and edit files and documents in the cloud. Drive is now the home 
of Google Docs. 
 
Google Drive comes with 5GB of storage for free. Additional storage 
can be purchased if needed. 
  
You can access Google Drive at any time by going to 
http://drive.google.com/ or by clicking on the Drive link at the very top 
of any Gmail page if you are logged in. 
 
The Google Dive home screen shows all your files and documents. 
From here you can view and edit, share, and create new documents. 
 

Google Docs 
 
Google Docs is web-based software for creating and editing documents, 
spreadsheets, presentations, webforms, and drawings. More information 
on webforms and drawings, which are not covered here, can be found at 
http://support.google.com/drive/bin/answer.py?hl=en&answer=87809 
and 
http://support.google.com/drive/bin/answer.py?hl=en&answer=177123 
 
To create a new document, go to http://drive.google.com/ and click the 
red CREATE button in the top left corner, then select the type of 
document you want to create. 
 

 

http://drive.google.com/�
http://support.google.com/drive/bin/answer.py?hl=en&answer=87809�
http://support.google.com/drive/bin/answer.py?hl=en&answer=177123�
http://drive.google.com/�
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Documents 
 
The Documents part of Google Docs is the word processor—essentially 
Google’s answer to Word. While this software works well for simple 
documents, be aware that more complex formatting is generally not 
possible with Google Docs. 
 

 
 
To avoid any confusion, create a name for your document. Click on the 
document name (Untitled document by default) and rename the 
document to something that makes sense to you. Just like regular file 
names, you can use spaces here. 
 
You have all the same basic tools as Word. Format your document using 
the options in the toolbar: 
 

 Print. 

 Undo and Redo. 

 
Paint formatting. Applies the current formatting to 
whatever you select after choosing this tool. 

 
Text style. You can use this to easily apply header 
styles. 

 
Font. This is a limited selection of Google Docs fonts, 
and does not necessarily correspond to fonts you have 
installed on your computer. 

 Font size. 

 Bold, italics, underline. 

 Font color. 

 Font background color. 

 
Insert link. This is useful for documents that will be 
used as PDFs, displayed on-screen, allowing the viewer 
to link to websites from your document. 

 
Insert comment. This adds a non-printing 
comment to your document. 

 Align left, center, right, or justified. 

 Adjust the spacing between lines of text. 

Document name (file name) 

Changes are automatically 
saved as you work 

Toolbar 

PRIVACY AND 
DATA SAFETY 

Because your data is stored on 
Google servers, privacy and 
security of your data may be a 
concern. 
 
The truth is, there is very little 
chance that you will run into 
problems, but it’s worth looking 
into the Google terms of 
service nevertheless. Read 
more at 
http://www.pcworld.com/article/
254638/should_you_worry_ab
out_google_drive_privacy_.ht
ml 
 

http://www.pcworld.com/article/254638/should_you_worry_about_google_drive_privacy_.html�
http://www.pcworld.com/article/254638/should_you_worry_about_google_drive_privacy_.html�
http://www.pcworld.com/article/254638/should_you_worry_about_google_drive_privacy_.html�
http://www.pcworld.com/article/254638/should_you_worry_about_google_drive_privacy_.html�
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 Insert numbered or bulleted lists. 

 Adjust paragraph indentation. 

 
Clear formatting. Removes any formatting changes 
you’ve made from the selected text. 

 
A few other tools available from the menus above the toolbar that are 
worth pointing out are: 
 
File > Page 
setup… Allows you to set the paper size and margins. 

Edit > Copy and 
Edit > Paste 

Works just like anywhere else. 

Insert > Image Insert an image from your computer, from a 
URL, or from your Google Drive account. 

Insert > 
Footnote 

Insert’s a footnote reference for the current 
position of the curser in the document. 

Insert > Page 
number 

Inserts automatically generated page numbers 
in the header or footer. 

Insert > Header 
or Insert > 
Footer 

Allows you to insert or edit the header and 
footer. You cannot have different headers and 
footers for different sections of the document. 

Tools > Word 
count 

See how many pages, words, and characters 
you have written. 

Table > Insert 
table 

Insert a table into the document. After inserting 
a table, you can add and remove rows and 
columns, and adjust table formatting, from the 
Table menu. 

Download a copy 
You can download a copy of your document in Microsoft Word format 
(.docx), as a PDF, or in a few other formats. Select File, Download as, 
and then the format you would like. 

Revision history 
There’s no need to turn on Track Changes or anything like that with 
Google Docs—it’s automatically keeping track of all your changes. To 
take a look at changes and previous versions of your document, go to 
File and choose See revision history. 
 



 
 

 

 

Gmail and Google Drive    APRIL 22, 2013 – PAGE 16 

 
 
Select a revision to view the earlier version, and click Restore this 
revision to revert back to it, or just close the Revision history with the X 
in the top right corner to go back to your current document. 

Closing the Document 
Make sure your document displays the text All changes saved in Drive 
and then just close the browser tab. 

Presentations 
 
When you create a new presentation you will be prompted to choose a 
theme. Select one and click OK. You can change the theme later by 
selecting Slide then Change theme… 
 

 
 
Your first slide is a Title slide by default. Add more slides with the red + 
in the top left corner. The default layout for additional slides is Title and 
body, but you can create new slides of different layouts by clicking the 
down arrow next to the + and selecting the layout you want. You can 
also change the format of any slide you have in your presentation by 
selecting Slide then Change layout and the desired layout. 
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You can change the slide background, insert images, and add transitions 
between slides from the toolbar. 
 
Present from within Google Docs by clicking Present, or click the 
down arrow next to that for more options, including presenting with 
speaker notes (useful if you have more than one display). You can step 
through slides with the left and right or up and down arrow keys. 
 
To export the presentation to PowerPoint of PDF format, select File, 
Download as and select the desired file type. 
 
You can also publish the presentation to the web, allowing others to 
view it anytime. Select File, then Publish to the web… Confirm that 
you want to start publishing, and you will see the window showing the 
public URL and giving you some options for web display of the 
presentation. 
 

Add a slide 

Slide browse 

Slide notes 

Start presentation 
Insert tools 
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Spreadsheets 
 

 
 
You can set up your document with headers and cell formatting, or just 
start entering your data and do the formatting afterwards. You can 
adjust row and column sizes by clicking and dragging the edge of the 
column headers or row numbers. 
 

Formula box 

Cell format options 

Wrap text Insert chart Functions 

Add sheet 
Select sheet 

PREVIEW 
Instead of downloading 
Microsoft Office documents 
attached to your emails, you 
can preview them in Google 
Docs. When viewing the email 
in Gmail, just click the Preview 
link next to the attachment. 
 
You can also preview 
Microsoft Office documents 
stored in your Google Drive by 
clicking on the file instead of 
converting it to a Google Doc, 
which is useful for looking at 
and printing documents. 
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If your text extends beyond the boundaries of a cell, you can always use 
the Wrap text option in the toolbar to have the content automatically 
wrap onto multiple lines. 
 
Google Spreadsheets has functions to perform sums, averages, counts, 
and much more. Select the Functions option in the toolbar and select 
the desired function or click More functions… for a full list of the 
(very) many functions available. After selecting the desired function, 
you will have to select the cells to use in the calculation, then press the 
Enter key. Calculation fields automatically update when the values it 
uses are changed. 
 
Insert charts by selecting the cells you want to use the data from and 
clicking the Insert chart option in the toolbar. Confirm the data range, 
select a chart (there are more options under the Charts tab), and click 
Insert. 
 

 
 
Sort your spreadsheet data by right-clicking on a column header or 
clicking on the down arrow that appears when the mouse pointer is over 
a column header, and select Sort sheet A > Z. 
 
You can export your spreadsheets to Excel (.xlsx) format, comma-
separated (.csv) format, PDF, and more. Select File, Download as, and 
select the desired file format.  
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Sharing 
 
One of the most powerful features of Google Docs is the ability to share 
and work on documents, presentations, and spreadsheets together. 
Multiple users can work on a single document simultaneously, and you 
can see changes from other users as they are made. Collaborators must 
all have Google accounts in order to join your document. 
 
Sharing a document is the first step. Either select the document in your 
Google Drive and click the  share button, or open the document and 
click the blue Share button in the top right corner. 
 

 
 
You can change access options to allow anyone with the provided link 
to edit the document, or just anyone at all. If you keep it private, you 
will share it only with people who you invite by entering their 
information in the Add people box. Enter names of people who are in 
your Gmail contacts, or enter email addresses. After entering 
collaborators, click Share & save. 
 
Collaborators will receive an email notifying them that you have shared 
a document with them, and can follow the included link to open the 
document. 
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When you are working on a document that someone else also has open, 
you will see color blocks for each additional user toward the top right 
corner of the screen, along with text indicating the number of other 
viewers. Click on that text to show additional information about who is 
working on the document, or to chat with all active users. 
 

 
 
Colored cursors representing each additional viewer are displayed 
within the document where they are working. 
 
Clicking on Shared with me in the left column of the main Google 
Drive screen can access documents that have been shared with you by 
others. 
 

 
 
 
 

Additional user cursor 
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The Cloud 
 
Everything created in Google Docs is saved in the cloud, but you can 
also place other files from your computer in your Google Drive. Files 
can be individually uploaded, or you can install Google Drive software 
for your computer that will automatically sync files placed in a Google 
Drive folder on your computer with your Google Drive online account. 

Uploading Files 
Uploading files is as simple as clicking the  upload button next to 
the CREATE button on the main Google Drive screen. 
 
While you can upload all file types, they cannot be edited using Google 
Docs unless you convert them to the Google Docs format. But beware: 
if you convert them there will be two versions—the original format and 
the new Google Docs format. 

Local Sync 
 

 
 
Download the Google Drive software. You can find it on the main 
Google Drive screen. Run the file that you download and follow the 
directions to install the software. A new folder will be created on your 
computer named Google Drive. On the mac, this folder is in your user 
folder (the same place as Documents, Downloads, Pictures, etc) by 
default. 
 
Open the Google Drive folder and you should see everything you 
already have in your Drive. If you open any files that are in the Google 
Docs format they will open within your Google account in a web 
browser window (e.g. Safari, Firefox, Chrome, or Internet Explorer). 
You cannot open or edit these documents if you are not connected to the 
internet. If you open other files, such as Microsoft Word documents, 
these will open in their respective applications. You can open, edit, and 
save them even if you are not connected to the internet, and they will be 
automatically uploaded the next time you are online. 
 
The local Google Drive software is useful if you have more than one 
computer on which you usually work. Installing the software on all 

Download the software 
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computers you use allows you to easily keep the files stored in Google 
Drive updated across them all. In this way, Google Drive works as an 
alternative to other cloud storage solutions like Dropbox.  

Convert Microsoft Office File to Google Document 
 
Convert a Microsoft Office file, like a Word document, into the Google 
Docs format by uploading the file. Then select the file in Google Drive, 
click the More button, select Open with, then Google Docs. A copy of 
the file will then be created in Google Docs format, and you will see 
both versions listed in your Google Drive. 
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Creating a Google Drive Account 
 
There’s nothing to do. You’re all set if you have Gmail! If you don’t yet 
have a Gmail account, follow the instructions for creating one under the 
Gmail section of this document. 
 
 
 
 
 

FOLDERS 
You can add folders to your 
Google Drive to help organize 
your files. These can be added 
and edited both in the Google 
Drive web interface and within 
Finder or Windows Explorer if 
you have the Google Drive 
software installed on your 
computer. 
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